
The AACA Library 
& You

An introduction to 
America’s Automotive Library 
and its services



LIBRARY SERVICES

Do you know what the library can do for you?

Collection
(3,000,000 
automotive-related 
documents)

Research
(Remote, & in-person 
assistance)

L&RC Online
(Website, social 
media, auto ads, & 
catalog)

Outreach
(Education & 
community 
partnerships)

Presenter
Presentation Notes
You can use this slide as your opening or closing slide.  Should you choose to use it as a closing, make sure you review the main points of your presentation.  One creative way to do that is by adding animations to the various graphics on a slide.  This slide has 4 different graphics, and, when you view the slideshow, you will see that you can click to reveal the next graphic.  Similarly, as you review the main topics in your presentation, you may want each point to show up when you are addressing that topic. Add animation to images and graphics: Select your image or graphic.Click on the Animations tab.Choose from the options.  The animation for this slide is “Split”.  The drop-down menu in the Animation section gives even more animations you can use.If you have multiple graphics or images, you will see a number appear next to it that notes the order of the animations.Note: You will want to choose the animations carefully.  You do not want to make your audience dizzy from your presentation.



Our User 
Community

• TV/Movie Producers
• Students & Schools

• Lawyers & Investigators
• Authors & Artists

• Mechanics
• Other Libraries & Museums

Who uses the library? 
You’d be surprised!
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COLLECTION
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Presentation Notes
After consulting a variety of sources, you will need to narrow your topic.  For example, the topic of internet safety is huge, but you could narrow that topic to include internet safety in regards to social media apps that teenagers are using heavily.  A topic like that is more specific and will be relevant to your peers.  Some questions to think about to help you narrow your topic: What topics of the research interest me the most?What topics of the research will interest my audience the most?What topics will the audience find more engaging? Shocking? Inspiring?



COLLECTION

 3,000,000 automotive-
related documents and 
memorabilia 

 Acquired through 
donations, auctions, and 
other procurements

 Chiefly represents factory 
documents & primary 
resources

Sales Literature

Shop Manuals & Parts Catalogs

Owner’s Manuals

Reference Books

Periodicals & Magazines

Photographs & Film

Toys & Models

Paint & Upholstery Albums

Blueprints & Diagrams

Annual Reports

Vehicles & More!
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After consulting a variety of sources, you will need to narrow your topic.  For example, the topic of internet safety is huge, but you could narrow that topic to include internet safety in regards to social media apps that teenagers are using heavily.  A topic like that is more specific and will be relevant to your peers.  Some questions to think about to help you narrow your topic: What topics of the research interest me the most?What topics of the research will interest my audience the most?What topics will the audience find more engaging? Shocking? Inspiring?



SPECIAL 
COLLECTIONS

 Borrowed collections from other 
car clubs and organizations

 Collection changes over time

Antique 
Motorcycle 

Club of America

Buick Heritage 
Alliance

Dodge 
Brothers Club

Hudson-Essex-
Terraplane

Hist. Society

Lincoln           
Motor Car 

Foundation

Nat. Corvette 
Restorers 

Society

National 
Woodie Club

Pierce-Arrow 
Society

Vintage 
Chevrolet Club 

of America
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Presentation Notes
After consulting a variety of sources, you will need to narrow your topic.  For example, the topic of internet safety is huge, but you could narrow that topic to include internet safety in regards to social media apps that teenagers are using heavily.  A topic like that is more specific and will be relevant to your peers.  Some questions to think about to help you narrow your topic: What topics of the research interest me the most?What topics of the research will interest my audience the most?What topics will the audience find more engaging? Shocking? Inspiring?



RESEARCH

• State-of-the-art facility

• Quiet environment

• Professional librarian 
assistance

• Scanning & copying 
services

• Access to entire collection

• Extra benefits for members

In-person 
assistance for 
researchers who 
visit the facility in 
Hershey

Remote 
research for 
researchers 
who are 
unable to visit 
in person
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Presentation Notes
Now, that you have narrowed your topic, you will want to organize your research in a structure that works.  There are some common organizational patterns based on the kind of research you are doing.  Organizational Structures: Cause and Effect- this kind of structure is great for explaining the causes and effects of a topicCompare and Contrast- in this pattern you highlight the similarities and differences of the topicExplain process- this structure is great for outlining a series of steps to follow; Definition- if you want to make sure your audience understands what something is using illustrations, meanings, clarifying misconceptions, you may want to use this structureClassification- a common organizational structure is grouping like topics or facts from the research together.  For instance, in the internet safety about social media apps, you may organize the research where you look at each social media app one at a time



AACA L&RC 
ONLINE

Search the library from 
home or anywhere! 
• Catalog
• Selected Advertisements
• Flat Files
• Periodicals, and More!
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Presentation Notes
When conducting research, it is easy to go to one source: Wikipedia.  However, you need to include a variety of sources in your research. Consider the following sources: Who can I interview to get more information on the topic?Is the topic current and will it be relevant to my audience?What articles, blogs, and magazines may have something related to my topic?Is there a YouTube video on the topic? If so, what is it about?What images can I find related to the topic?



AACA L&RC 
ONLINE

Can’t visit us in person? 
Don’t worry, the library 

is open 24/7 online!
Access information about us through our website Access

Get started by filling out the research request formRequest

Browse the automotive advertisements collectionBrowse

Search the catalogSearch

Connect with us on FacebookConnect

Watch video clips from the collection on YouTubeWatch
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FLAT FILES
• Material that doesn’t fit 

into Make & Model-specific 
organization:

• Clubs & Organizations
• Events
• Fluids
• Parts & Accessories
• People
• Racing
• Tools
• Vehicles by Type (Tractors, 

Scooters, Replicas, 
Professional Cars, etc.)

Always up-
to-date —
always 
available

Accessible 
via L&RC 
website
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Now, that you have narrowed your topic, you will want to organize your research in a structure that works.  There are some common organizational patterns based on the kind of research you are doing.  Organizational Structures: Cause and Effect- this kind of structure is great for explaining the causes and effects of a topicCompare and Contrast- in this pattern you highlight the similarities and differences of the topicExplain process- this structure is great for outlining a series of steps to follow; Definition- if you want to make sure your audience understands what something is using illustrations, meanings, clarifying misconceptions, you may want to use this structureClassification- a common organizational structure is grouping like topics or facts from the research together.  For instance, in the internet safety about social media apps, you may organize the research where you look at each social media app one at a time



SEARCHING FLAT FILE FINDING AID



TO SEARCH USE 
CTRL F

https://docs.google.com/document/d/12pOoddJIULB6oBlW9X5OkENPTdZsGi-JbIQx7NJecvA/edit?tab=t.0#heading=h.9721znf4mv1j


OUTREACH
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Presentation Notes
After you’ve done your research, it’s time to put your presentation together.  The first step in the process is to introduce the topic.  This is a great time to connect your topic to something that your audience can relate.  In other words, why should they listen to all the information you will be sharing in your research presentation?  What is in it for them?  You may also want to include a graphic or image to grab their attention.Feel free to duplicate this slide by right-clicking on this slide in the slides pane to the left and select Duplicate Slide.The next step in your presentation is to state your claim or topic clearly.  Your teacher may even call this your thesis.  As you state your thesis, you may find that this layout is not the best layout for your claim or topic.  You can change the layout by clicking the drop-down menu next to the Layout in the Slides menu section.  You can choose Two Content, Comparison, or Picture with Caption.  Note: A different layout might change the look of the icons on this page.You will also want to state your facts.  You have done the research now share some of the interesting facts with your audience.  Facts do not have to be boring; you can communicate facts in a variety of ways by going to the Insert Tab.  In the Insert tab you can: Insert pictures from your computer or online.Add a chart Create some SmartArtInsert a variety of icons to help your facts come to life.  Note: You can change the color of the icons by selecting the icon and then click on the Format tab and then Graphics Fill.  From there, you will choose a color from the list or choose More Fill Colors to give you more options.Since this research presentation is a result of your hard work and searching, you want to make sure you support the claims or points in your presentation with facts from your research findings.  Make sure you give the author proper credit for helping you share your ideas.  If one of your sources has a video that is relevant to your topic, you can add the video as added support.  Keep in mind the length of the video and the amount of time you have for your presentation.  For a 5 minute speech, the video should be no longer than 30 seconds.  Questions to consider: How will you state the author of the source?Will you need to cite the source on the slide?What are some ways you can engage your audience so they feel like they are a part of the presentation?  Some ideas to consider is by taking a quick poll like: by a show of hands, how many of you think school uniforms are a way to cut down on bullying?  Another suggestion is to have them hold up a certain number of fingers to see if they agree or disagree.  Finally, you can share a story that the audience can relate to that makes them laugh.After all the applause, your audience may have some questions.  Be prepared to answer some of their questions by making a list of questions you think they might ask. You may also want to share the presentation with them by providing the link to your presentation, if they want more information.



OUTREACH

• Public education through 
programs and seminars

• Group tours of the facility
• Attendance at events like 

Convention and Hershey 
Nationals

• Collaboration with other libraries
• Partnerships with other 

organizations in the community

More than 
just the 
building
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OUTREACH

Don’t miss our second seminar

“Women in Automotive 
History: A Collaborative 
Exhibition”

Friday at 4pm in this same room

More than 
just the 
building
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The AACA Library 
Is YOUR Library

ACCESS LEARNCONNECTEXPLORE
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THANK YOU!
aacalibrary.org         717.534.2082

Matt Hocker
Research 
Librarian

mhocker@aaca.org

Amoi Goldman
Research 
Librarian

agoldman@aaca.org

Jim Kapoun
Research 
Librarian

jkapoun@aaca.org

Jen Wolfe
Library Director
jwolfe@aaca.org
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